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Introduction

This tutorial discusses a 2D finite element model of a standard three-core, lead sheathed
XLPE HVAC! submarine cable, with a main conductor cross section of 500 mm? ,and a
phase-to-phase operating voltage of 220 kV. Capacitive effects are analyzed. The tutorial
validates the assumption that for the capacitance and the charging currents, analytical

approaches are sufficiently accurate (verification is included).

The influence of material properties, the cable’s length and bonding types is discussed.
The model justifies the approach chosen in subsequent tutorials in this series, most
notably, the Bonding Capacitive and the Inductive Effects tutorials (chapters 3 and 4).

Model Definition

The geometry of the cable is shown in Figure 1. It describes a detailed cross section (as
built in the Introduction tutorial). A large number of material properties is included for
the metals, the polymers, and the sea bed.
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Figure 1: The cable’s cross section, including the three phases (yellow), screens (ved), the XLPE
(white), the armor (blue), and the fiber (green).

1. Cross-linked polyethylene, high-voltage alternating current.
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THEORETICAL BASIS
The model solves a 2D in-plane current conservation problem in the frequency domain.
This includes the following:

E=-VV
V-D=p (1)
V-J = jop,

for the electric field, Gauss’s law, and current conservation. The differential form is used
here, together with the SI unit system: E,; D, and J are in V/m, C/mz, and A/mz,

respectively. Note that defining the electric field solely by means of the electric potential
gradient — thus excluding the terms based on the magnetic vector potential A — is valid

only when the electric field is cur/-free, that is; when Faraday’s law evaluates to zero:
VXE = -joB = 0. (2)

If the electric field would not be curl-free, there would be no such thing as a unique
electric potential V' (even with the proper boundary constraints in place). In those cases
you can walk along a closed loop, integrating the electric field as you go (to determine the
local potential), and end up in the same spot with an electric potential that differs from the
one you started with. The chosen electric field definition E = —VV basically implies that in-

plane electric fields caused by electromagnetic induction are assumed to be negligible.

Admittedly, the 3D twist models in the Inductive Effects 3D tutorial will show you that
magnetically induced in-plane electric fields 4o form, and that they are not curl-free (they
drive small eddies in the conductors). Those electric fields are on the order of several Volts
per meter however; they are completely overshadowed by the curl-free electric fields from
the phase-to-ground voltage of 127 kV. And even if they would have had the same order
of magnitude, their direction is such that they do not contribute to the phase-to-ground

capacitive phenomenon. This justifies the set of relations shown in Equation 1.

Apart from the potential definitions and conservation laws, we have the following

constitutive relations (the ones containing material properties):

D = ¢y, E = ¢E
J = oE.

3

Some people may prefer to include the displacement current in the definition of the
current. This gives you V - J' =0 and J' = 6E + joD for the current conservation law and

the current definition, respectively.
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Regardless the convention you choose, when you piece everything together, you end up
with the following 2D partial diffevential equation for the dependent variable V:

-V.-((c+joe)VV) = 0. 4)

The Electric Currents interface uses this conservation law to determine the value of Vin
the domains. For the boundaries, several Dirichlet conditions are used. For the three

phases with phase-to-ground voltage V; we have:

5K k5
V., = VO Vb = Voe V.= Voe 5 (5)
where a complex exponent &® is used to set a 120° phase shift between the phases.

Combined with V; = 0 for ground (the infinity condition used at the outer boundary), this

gives you a complete set of equations.

MODELING APPROACH
The tutorial starts with the basics, by applying a potential to the phases and the sea bed,
using the Terminal and the Ground feature. As a result the screens are left floating, and

properties like capacitance are rather nontrivial.

In practice, however, the screens are typically grounded. For determining the cable’s
capacitive properties per phase in nF/km, oftentimes the analytical relation for coaxial

capacitors is used:

2neqe,

~ In@R,/Ry)’ ©

where ggg, refers to the insulator’s permittivity, and Rq, Rg, refer to the insulator’s outer,
and inner radius, respectively. From the capacitance C and the applied voltage V), the

charging current per phase in A/km can be derived as follows:
I, = joCV,. (N

Equation 6 implicitly assumes a perfect insulator, sandwiched between two perfect
conductors. What is more, it assumes that each phase together with its screen can be
considered an isolated problem: Capacitive effects between the screens and ground are

completely neglected.

In other words, the phases are considered to be at Vie!®, the screens are considered to be
grounded, and the currents outside the screens are assumed to be zero. Near the ground

and feeding point these assumptions seem valid. After 10 km of cable however, with
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single-point bonding? applied, conditions are less clear. Results from the Inductive Effects
and the Bonding Capacitiye tutorials are used to make an educated guess on how much

the phase and screen potentials will deviate from their value near the ground point.

ON ILL-POSED PROBLEMS

The model includes a very large contrast in conductivity, about 6 ,/0gy ~ 2.1 - 1016,
where o, refers to the copper conductivity and weg can be considered the displacement
current conductivity in air (the logic behind this follows from Equation 4). This large

contrast leads to what is known as an é//-posed problem.

The cable’s cross section is basically a complex system of resistors and capacitors. The
current, when crossing from the phase to the ground, will encounter a very large
impedance (the XLPE). Then, it will encounter a very small impedance (the screen) and

continue in the polyethylene (assuming the lead is a floating potential).

Since the impedance of the XLPE is on the order of 1015 times larger than the impedance
in the lead, the voltage drop in the lead will be about 101 times smaller. This voltage drop
is numerically completely insignificant. Resolving this large contrast would require an
extreme precision (and consequently, a lot of computational resources). Even so, this
voltage drop is needed in order to determine the amount of current flowing through the
metal.

One solution is to just reduce the contrast to a level that can be resolved more easily; about
10%, to 101%. When you are interested in the currents (and potential gradient) in the
insulators, a material with a conductivity 108 times higher is more than sufficient for
modeling metallic behavior. This is also why the semi-conductive compound behaves like

a metal — and so does the sea bed — even though it has a conductivity less than sea water.

Reducing the contrast will not significantly influence accuracy, as the XLPE’s impedance
will still completely dominate the results: Just picture a 1 Q and a 1 pQ resistor in series,
compared to a 1 Q and a 1 pQ resistor; the current will be similar.

Another solution is to exclude the metal domain from the model altogether and put an
equipotential boundary condition on its outer boundaries instead. In that case, the
potential distribution inside the metal is not part of the finite element model any longer;
it is assumed to be perfectly constant. This is the approach used by the Terminal features.
In terms of resistors placed in series, it means the 1 pQ resistor is removed from the circuit
altogether.

2. For more information on the different bonding types, see the Bonding Capacitive and Bonding Inductive
tutorials in this series.
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Please be aware though, when you place insulators and metals in parallel, it will be the
metals that are dominant (this case is demonstrated in the Bonding Capacitive tutorial).
When this is the case, oftentimes it is the insulators that are excluded, or given less
contrasting material properties. People tend to be much more comfortable with excluding

insulators from an electric currents model. Obviously, this is not always appropriate.

Results and Discussion

For 10 km of cable with single-point bonding applied and all voltage inducing effects in-

3

phase — the worst-case scenario® — it turns out the analytical approximation for the

cable’s capacitance (Equation 6), still holds: 0.14 pF/km.

The drop in phase potential along the cable due to the AC resistance is estimated to be
490 V. The raise in screen potential is expected to be 83 V +473 V at most, from
capacitive and inductive effects, respectively (as found in the Bonding Capacitive and
Bonding Inductive tutorials). Thanks to the large phase-to-ground feeding potential of
127 kV (as given by 220 /./3 ), all these secondary voltages are shown to be negligible?.

freq(1)=50 Hz Electric potential (V)

A 1.27x10°
x10°

V -6.33x10"

Figure 2: The real part of the cross-sectional potential distribution at phase ¢ = 0.

3. While still considering nominal conditions, that is; no short-circuit or electromagnetic breakdown.

4. That is, under normal operating conditions, power surges are a different matter.
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With the screen potential relatively close to zero, the capacitive coupling between the
screens is insignificant. This justifies the “isolated phase” approach chosen in the Bonding
Capacitive tutorial. Furthermore, the in-plane current densities due to capacitive effects
are proven negligible compared to the applied and induced out-of-plane current densities;
about 2.95 - 107 times smaller.

This partly justifies the approach chosen in the Inductive Effects tutorial, where in-plane
currents are neglected. Additionally, it tells us 3D cable models will usually end up
focusing on the inductive (or thermal) part of the device, as resolving the small in-plane
displacement current densities together with the much stronger out-of-plane conduction

current densities would require an impractical numerical precision.

In the cross section of the cable, the large contrast in material properties (as given by

Opp/ € =6,5 - 10 ) makes it possible to consider the cross-linked polyethylene

xlpe
(XLPE) a perfect insulator, and the lead (Pb) a perfect conductor — the copper even more
so. Even the semi-conductive compound with a conductivity of about 2 S/m can be

considered a perfect conductor. This, too, corresponds to the analytical approximation, as

shown in Equation 6.

freq(1)=50 Hz Displacement current density norm (A/m?)
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Figure 3: The displacement curvent density norm in the XLPE insulation.
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For all intents and purposes, the COMSOL Multiphysics model shows perfect
correspondence to the analytically determined figures. In the end, when it comes to the

cable’s capacitance, all details in the model turn out to be superfluous. Except for three:
¢ The cross-linked polyethylene’s permittivity.
¢ The outer radius of the cross-linked polyethylene.

¢ The inner radius of the cross-linked polyethylene.

This is crucial knowledge. Numerical models like this are capable of showing the essence
of a device before prototyping starts. It allows engineers that are new to a certain field to

figure out what is important.

ON ACCURACY
You might be tempted to make the model correspond to theoretical results or
specifications up to the tenth digit — spending a lot of time on geometric details, mesh

quality, and so on. And you might think a more “accurate” model is somehow better.

Please keep in mind though, by far the most important figure here is &gpe (2 measured
quantity given in two digits). If that figure is off by 5%, the rest of the model will be off,
too, regardless of how many details you put in it or how well it corresponds to the

analytical solution. After all, any model is only as accurate as the data you put into it.

That being said, the behavior itself is very accurate. If you want to make a qualitative
assessment for a device (to understand its nature), even material properties that are 50%
off will do fine.

References

1. International Electrotechnical Commission, Electric cables — Calculation of the
Current Rating; IEC 60287; IEC Press: Geneva, Switzerland, 2006.

2. Video file submarine_cable_z_animation_01_floating_screen,

available for download at www.comsol.com/model /cable-tutorial-series-43431.

3. Video file submarine_cable_z_animation_02_fixed_screen,

available for download at www.comsol.com /model /cable-tutorial-series-43431.

Application Library path: ACDC_Module/Tutorials, Cables/
submarine_cable_02_capacitive_effects
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Modeling Instructions

This tutorial will focus on capacitive effects. The instructions on the following pages will
help you to build, configure, solve, and analyze the model. If anything seems out of order,
please retrace your steps. The finalized model — available in the model’s Application

Libraries folder — can help you out. You can compare it directly to your current model by

means of the Compare option in the Developer toolbar.

ROOT

The geometry, materials, and mesh have been prepared in the Introduction tutorial
(chapter 1). They have been saved in the file submarine_cable_01_introduction.mph.
You can start by opening this file and saving it under a new name.

Hint: if you are new to COMSOL Multiphysics, it is worthwhile to check out the
Introduction tutorial first.
I From the File menu, choose Open.

2 Browse to the model’s Application Libraries folder and double-click the file
submarine_cable_01_introduction.mph.

3 From the File menu, choose Save As.

4 Browse to a suitable folder and type the filename
submarine_cable_02_capacitive_effects.mph.

GLOBAL DEFINITIONS
Some parameters have been prepared for running the model, and verifying results

afterward. You can load them from a file.
Electromagnetic Parameters
I In the Home toolbar, click Pi Parameters and choose Add > Parameters.

2 In the Settings window for Parameters, typec Electromagnetic Parameters in the
Label text field.

3 Locate the Parameters section. Click Load from File.
4 Browse to the model’s Application Libraries folder and double-click the file

submarine_cable_c_elec_parameters.txt.

Eighteen new parameters have been added. 0, w0, VO and IO are pretty straightforward,
where 1/sqrt(3) and sqrt(2) convert from phase-to-phase to phase-to-ground, and
from root mean square (RMS) to peak value respectively. Scup to Dsarm are some material
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properties and the skin depths derived from those (as used in the Inductive Effects
tutorials), and Rcon, Rpbs are analytically determined DC resistances.

The parameter Cpha is the cable’s analytically determined capacitance per phase, as given
by Equation 6. Here, Ex1pe refers to the relative permittivity of XLPE; 2.5 (the value is

taken from IEC 60287 [1]). In the expression for Cpha, the metals and the semiconductive
compound are considered perfect conductors, so the outer and inner radius of the XLPE

layer is used.

Lastly, the charging current per phase, Icpha, follows from Equation 7. It evaluates to
about 5.5 A/km. Note that this approach implicitly assumes a constant potential

everywhere along the cable, with the screen being grounded.

Let us investigate the situation without these assumptions, check the details numerically,
and see if'it leads to the same conclusions as the analytical description. Start by adding the

physics and a new study.

ADD PHYSICS
I In the Home toolbar, click J: Add Physics to open the Add Physics window.

2 Go to the Add Physics window.
3 In the tree, select AC/DC > Electric Fields and Currents > Electric Currents (ec).
4 Click the Add to Component | button in the window toolbar.

5 In the Home toolbar, click L Add Physics to close the Add Physics window.

ELECTRIC CURRENTS (EC)

I In the Settings window for Electric Currents, locate the Domain Selection section.
2 From the Selection list, choose Electromagnetic Domains.

3 Click the " Zoom to Selection button in the Graphics toolbar.
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ADD STUDY
I In the Home toolbar, click :\‘51 Add Study to open the Add Study window.
2 Go to the Add Study window.

3 Find the Studies subsection. In the Select Study tree, select General Studies >

Frequency Domain.
4 Right-click and choose Add Study.
5 In the Home toolbar, click :\‘j:i Add Study to close the Add Study window.

STUDY |

Step I: Frequency Domain
I In the Settings window for Frequency Domain, locate the Study Settings section.

2 In the Frequencies text field, type 0.

MATERIALS
Now, you will see that COMSOL starts detecting missing material properties. The
properties that should be added are listed in the following table. Please check all of them

for the correct value, even the ones that are already filled in. A guick option is to copy-paste
the values directly from this *.pdf file to COMSOL.

I In the Model Builder window, under Component | (compl) > Materials, check the

following properties:

Label sigma [S/m] epsilonr
maté Cross-linked polyethylene 1e-18[S/m] Exlpe
(XLPE)
matl | Copper Scup 1
mat|2 Lead Spbs 1
mat|3 Galvanized steel Sarm 1

Please be aware that in the end, many material properties will be either ignored,
overridden, or proven to be insignificant. Figuring out which ones are important
oftentimes is an essential part of research. For more on this, see section Results and

Discussion.

Modeling Instructions — Floating Screen

Now that the materials have been set and double-checked, please have a look at the

physics. As a starting point, assume that the sea bed is grounded and that the 2D cross
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section that this model represents is located close to the point of excitation, that is, that
the phase voltage norm is equal to VO.

ELECTRIC CURRENTS (EC)

Ground |

I In the Physics toolbar, click £ Boundaries and choose Ground.
2 Select Boundaries 12, 13, 338, and 348 only.

3 Click the " Zoom to Selection button in the Graphics toolbar.
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Current Conservation in Solids 2
I In the Physics toolbar, click @ Domains and choose Current Conservation in Solids.

2 In the Settings window for Current Conservation in Solids, locate the Domain Selection
section.

3 From the Selection list, choose Metals.

4 Click the " Zoom to Selection button in the Graphics toolbar.
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This last feature (Current Conservation 2) needs some explaining. At this point, it just
overrides the default current conservation feature using the same settings. We will get
back to this later.
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Phase |

I In the Physics toolbar, click @ Domains and choose Domain Terminal.
2 In the Settings window for Domain Terminal, type Phase 1 in the Label text field.

3 Locate the Domain Selection section. From the Selection list, choose Phase 1.

0.12 rln
0.1
0.08
0.06
0.04
0.02
0
-0.02
-0.04
-0.06

-0.08

-0.1

-0.12

4 Locate the Terminal section. From the Terminal type list, choose Voltage.

5 In the V| text field, type VO.

Phase 2

I In the Physics toolbar, click @ Domains and choose Domain Terminal.

2 In the Settings window for Domain Terminal, type Phase 2 in the Label text field.

3 Locate the Domain Selection section. From the Selection list, choose Phase 2.
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4 Locate the Terminal section. From the Terminal type list, choose Voltage.

5 In the V| text field, type VO*exp(-120[deg]*j).

Phase 3

I In the Physics toolbar, click @ Domains and choose Domain Terminal.

2 In the Settings window for Domain Terminal, type Phase 3 in the Label text ficld.
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3 Locate the Domain Selection section. From the Selection list, choose Phase 3.
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4 Locate the Terminal section. From the Terminal type list, choose Voltage.

5 In the V| text field, type VO*exp (+120[deg]*j).

Note that, since we are in the frequency domain, expressions like exp (-120[deg]*j)
or exp(-j*2*pi/3) may be used to set a 120° phase shift between the AC voltages on

the three main conductors.

So now you have added a current conservation law with some material properties, a
ground reference and a form of excitation. Together with the frequency domain study —
with the frequency set — you should be free to go.

STUDY 1|
I In the Home toolbar, click Compute.

An error should appear: “Failed to find a solution”.
2 Click OK.

So what happened here? In numerical mathematics, this model is known as an é//-posed
problem. When modeling (regardless of the software used) you will encounter this
problem every once in a while. As explained in section On Ill-Posed Problems, one of the
solutions is to reduce the contrast in conductivity. You can set the conductivity of the
metals to the seemingly small value of 5[S/m] (the conductivity of sea water). This brings

us back to Current Conservation 2.
Current Conservation in Solids 2
I In the Model Builder window, click Current Conservation in Solids 2.

2 In the Settings window for Current Conservation in Solids, locate the

Constitutive Relation Jc-E scction.

3 From the o list, choose User defined. In the associated text field, type 5[S/m].
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For all the metals (excluding the phases) you have now overridden the default conductivity

with a user-defined setting. Proceed by computing the solution.

In the Home toolbar, click = Compute.

RESULTS

Electric Potential (ec)

The first thing to notice is that the Electric Potential plot is zoomed in quite a bit. This is
because it is still locked to the camera settings used in the geometry and the mesh. Let us
give it separate view settings.

I In the Settings window for 2D Plet Group, locate the Plot Settings section.

2 From the View list, choose New view.

Surface |

I In the Model Builder window, expand the Electric Potential (ec) node, then click
Surface I.

In the Settings window for Surface, click to expand the Quality section.
From the Evaluation settings list, choose Manual.

From the Resolution list, choose Fine.

In the Electric Potential (ec) toolbar, click Plot.

Click the Zoom Extents button in the Graphics toolbar.
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The second thing to notice is that compared to the polymers the sea bed is conducting
so well that it is behaving like an equipotential (like a metal). The currents are too small

for a significant potential drop to be seen there.

You can exclude the sea bed from the plot by adding a selection to the solution.
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Study [/Solution | (soll)
In the Model Builder window, expand the Results > Datasets node, then click Study 1/
Solution | (soll).

Selection

I In the Results toolbar, click g Attributes and choose Selection.

2 In the Settings window for Selection, locate the Geometric Entity Selection section.
3 From the Geometric entity level list, choose Domain.

4 From the Selection list, choose Cable Domains.

5 Click the " Zoom to Selection button in the Graphics toolbar.

0.12 :n

0.1
0.08
0.06
0.04

0.02

-0.02
-0.04
-0.06
-0.08

-0.1

-0.12

Electric Potential (ec)

I In the Model Builder window, under Results click Electric Potential (ec).

2 In the Electric Potential (ec) toolbar, click Plot.
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3 Click the Zoom Extents button in the Graphics toolbar.
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Next, let us have a look at the electric field norm and some current plots.

Electric Field (ec)
I In the Model Builder window, click Electric Field (ec).

2 In the Electric Field (ec) toolbar, click Plot.
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3 Click the Zoom Extents button in the Graphics toolbar.
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The electric field is most prominent in the insulators, in the metals it is negligible (as it
should). Significant electric fields exist outside the screens, suggesting the screens are
not doing a very good job (we will get back to that later). Furthermore, the field is
much stronger than the electric fields caused by magnetic induction (those are not curl-

free, this one is, see section Theoretical Basis).

In fact, the field strength is so large that the cable would not work; it is way above the
level for electrical breakdown in air (which is about 3 kV/mm). These high levels occur
in singularities that are located on sharp corners with contrasting material properties.
Close to the main conductors this effect occurs too, certainly if you would model their
individual strands explicitly. This is one of the main reasons for having the

semiconductive compound; it smoothens the electric field and prevents breakdown.
Displacement Current Density Norm (ec)
I Right-click Electric Field (ec) and choose Duplicate.
2 In the Settings window for 2D Plot Group, type Displacement Current Density Norm

(ec) in the Label text field.

Surface |
I In the Model Builder window, expand the Displacement Current Density Norm (ec) node,

then click Surface 1.

2 In the Settings window for Surface, locate the Expression section.
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3 In the Expression text field, type sqrt(abs(ec.JdX)~2+abs(ec.JdY)"2).

4 Select the Description checkbox. In the associated text field, type Displacement
current density norm.

5 In the Displacement Current Density Norm (ec) toolbar, click Plot.
6 Click the Zoom Extents button in the Graphics toolbar.
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For many quantities, predefined variables are available. You can find them using the
buttons in the top-right corner of the Expression section, just above the text input field for
the expression. There is some autocompletion functionality too (try pressing Ctrl+Space
with the text input field in focus). For the displacement current density norm, however,

there is no predefined variable, so you had to insert your own definition.

The variables ec.JdX and ec.JdY are the X and Y-component of the 2D complex
displacement current field, where the prefix “ec.” refers to the physics interface
responsible for defining it; Electric Currents. The norm of a complex vector field is defined
as || Jqll = (| T x| %+ [Ty |HV2.

Now, you can use the same approach for the conduction (or induced) current density

norm.

Conduction Current Density Norm (ec)
I In the Model Builder window, right-click Displacement Current Density Norm (ec) and
choose Duplicate.
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2 In the Settings window for 2D Plot Group, type Conduction Current Density Norm
(ec) in the Label text field.

Surface |
I In the Model Builder window, expand the Conduction Current Density Norm (ec) node,
then click Surface 1.

2 In the Settings window for Surface, locate the Expression section.

3 In the Expression text field, type sqrt(abs(ec.JiX)*2+abs(ec.JiY)"2), thatis,
replace “d” with “i”.

4 In the Description text field, type Conduction current density norm.

5 In the Conduction Current Density Norm (ec) toolbar, click Plot.

6 Click the Zoom Extents button in the Graphics toolbar.
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Please note that the displacement currents are negligible in the conductors, including
the semiconductive compound. Likewise, the conduction currents are negligible in the
insulators. For all intends and purposes, it is accurate to consider the XLPE a perfect
capacitor and the semiconductive compound a perfect resistor. Therefore, the
conductivity of the XLPE could just as well have been zero. The same goes for the

semiconductive compound’s permittivity.

Next, let us see if we can gain more insight in the phase dependency of the solution, by

creating a nice animation.
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Streamline |
In the Model Builder window, under Results > Electric Potential (ec) right-click Streamline |
and choose Disable.

Surface |

I In the Model Builder window, click Surface 1.

2 In the Settings window for Surface, locate the Coloring and Style section.
3 From the Scale list, choose Linear symmetric.

Height Expression |

I Right-click Surface I and choose Height Expression.

2 In the Electric Potential (ec) toolbar, click Plot.

3 Click the '\I/' Go to Default View button in the Graphics toolbar.

4 In the Model Builder window, click Height Expression I.

freq(1)=50 Hz Electric potential (V)
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x10°

10

-10
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Animation |
I In the Results toolbar, click [ Animation and choose Player.

2 In the Settings window for Animation, locate the Animation Editing section.
3 From the Sequence type list, choose Dynamic data extension.
4 Locate the Frames section. In the Number of frames text field, type 60.

5 Locate the Playing section. From the Repeat list, choose Forever.
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6 Click the E Play button in the Graphics toolbar (see the animation from ref. [2]).

Hint: If genevating the animation takes too long on your machine, change the
qualiry/resolution setting of the corresponding surface plot from fine to coarse.

One thing to notice is that the metals (that have been put to 5[S/m] ) indeed manage
to behave like equipotential domains, as they should. Furthermore, the screen is floating
freely between the phase (the central conductor) and the environment. This goes for
the individual armor wires too. Clearly, this behavior is not as intended; the screen
should be grounded. Let us see if this is still the case, even at a distance of ten kilometers

from the ground point. For this, we will introduce some new parameters.

7 Click the Stop button in the Graphics toolbar.

Modeling Instructions — Fixed Screen

GLOBAL DEFINITIONS

Electromagnetic Parameters

I In the Model Builder window, under Global Definitions click Electromagnetic Parameters.
2 In the Settings window for Parameters, locate the Parameters section.

3 In the table, enter the following settings:

Name Expression Description
Vdcon I0*Lcab*53[mohm/km] Voltage drop across phase
(approximate)
Vrpbs ((Icpha*Lcab)/2*Rpbs*Lcab)+ Voltage raise across screen
473[V] (approximate)

Here, 53[mohm/km] refers to the AC resistance per phase as given by the Inductive
Effects tutorial. This resistance is far more dominant than the cable’s capacitance or
inductance (those are on the order of pF and tenths of mH). Multiplying with the total
length and the rated current gives an educated guess for the voltage drop; about 490 V.

For the voltage raise in the lead sheath we assume a worst-case scenario: single-point
bonding with all voltage inducing effects in-phase. From the Bonding Capacitive
tutorial we have the expression (Icpha*Lcab)/2*Rpbs*Lcab, giving the voltage
induced by the charging currents (about 83 V). The remaining part, 473 V, is caused
by inductive phenomena. The value has been determined half-way the Bonding
Inductive tutorial.
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4 In the table, enter the following settings:

Name Expression Description
V1 V0-Vdcon Phase to ground voltage (after 10km)
V2 0+Vrpbs Screen to ground voltage (after 10km)

You might feel we are thinking in circles here: Proving a point using data from other
models that have been justified using the results from this one. This is where the
qualitative assessment comes into play: The proof will still hold, even if the educated
guess for the voltages is oft by 100%. Feel free to check this.

So the potential in the central conductor is more or less VO, the potential in the screen is
more or less grounded. Let us put it in the model and recompute.

ELECTRIC CURRENTS (EC)

Phase |

I In the Model Builder window, under Component | (compl) > Electric Currents (ec) click
Phase I.

2 In the Settings window for Domain Terminal, locate the Terminal section.
3 In the V| text field, type V1.

Screen |

I Right-click Phase | and choose Duplicate.

2 In the Settings window for Domain Terminal, type Screen 1 in the Label text field.

3 Select Domain 55 only.
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4 Locate the Terminal section. In the V) text field, type V2.

Phase 2

I In the Model Builder window, click Phase 2.
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2 In the Settings window for Domain Terminal, locate the Terminal section.

3 In the V) text field, type Vi*exp(-120[deg]*j), that is; replace “V0” with “V1”.
Screen 2

I Right-click Phase 2 and choose Duplicate.

2 In the Settings window for Domain Terminal, type Screen 2 in the Label text field.

3 Select Domain 101 only.
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4 Locate the Terminal section. In the V) text field, type V2*exp(-120[deg]*j).
Phase 3

I In the Model Builder window, click Phase 3.

2 In the Settings window for Domain Terminal, locate the Terminal section.

3 In the V| text field, type V1*exp(+120[deg]*j).

Screen 3

I Right-click Phase 3 and choose Duplicate.

2 In the Settings window for Domain Terminal, type Screen 3 in the Label text field.

3 Select Domain 54 only.
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4 Locate the Terminal section. In the V) text field, type V2*exp (+120[deg]*j).
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STUDY |
In the Study toolbar, click = Compute.

RESULTS

Electric Potential (ec)

I In the Electric Potential (ec) toolbar, click Plot.

2 Click the '\I/' Go to Default View button in the Graphics toolbar.

freq(1)=50 Hz Electric potential (V)

A 1.27x10°
x10°

V -6.33x10"

Apart from the XLPE, the cable is starting to look like an equipotential. Hint: you can
investigate the phase dependency by playing the corvesponding animation, also
available as refevence [ 3].

Let us inspect the areas outside the screen, by changing the selection applied to the

solution.

Selection
I In the Model Builder window, under Results > Datasets > Study 1/Solution 1 (soll) click
Selection.

2 In the Settings window for Selection, locate the Geometric Entity Selection section.

3 From the Selection list, choose Insulators (External to Phase).
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4 Click the " Zoom to Selection button in the Graphics toolbar.
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Electric Potential (ec)
I In the Model Builder window, under Results click Electric Potential (ec).

2 In the Electric Potential (ec) toolbar, click Plot.
3 Click the \T/' Go to Default View button in the Graphics toolbar.

freq(1)=50 Hz Electric potential (V)
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This is a worst-case scenario though. In practice, capacitive and inductive effects will
show a 90° phase shift with respect to resistive effects, in opposite directions even.

One detail you might point out is that since the armor is twisted, all armor wires should
have the same potential (that is, the armor as a whole should behave like an equipotential).
You can achieve this by applying a single terminal to the entire group of armor wires, and

setting its excitation form to Current excitation with zero current.
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All armor wires will then behave like one entity, introducing a total net current of zero
Ampere, as floating conductors do. It will not make any difference to the final result
though (the lumped parameters). Let us see how this adjusted model compares to the
analytical results (and the specifications).

Phase AC Capacitance
I In the Results toolbar, click (%5) Global Evaluation.

2 In the Settings window for Global Evaluation, type Phase AC Capacitance in the Label
text field.

3 Locate the Expressions section. In the table, enter the following settings:

Expression Unit Description

(imag(ec.Y11)/ec.omega)/1[m] uF/km Phase 1 capacitance

(imag(ec.Y22)/ec.omega)/1[m] uF /km Phase 2 capacitance

(imag(ec.Y33)/ec.omega)/1[m] uF /km Phase 3 capacitance

Cpha uF/km Capacitance per phase
(analytic)

Here, ec.Y11 is one of the elements of the admittance matrix. The numbers refer to
the terminal numbers. This particular variable refers to the current through Terminal I,
divided by the voltage on Terminal I.

Selecting the imaginary part and dividing by ec.omega, gives you the capacitance for
that terminal. Since this is a 2D model, with the default out-of-plane thickness of one
meter applied, the capacitance is divided by 1[m]. Cpha is the analytical value for

comparison.

4 Click = Evaluate.

TABLE |
I Go to the Table | window.

The results should be around 0.14 pF/km for all three phases (as given by the
specifications). As you can see, there is some capacitive pollution from the external
insulators in the third or fourth significant digit (that is the effect of single-point
bonding and ten kilometers of cable). If we would set V1 equal to VO and V2 to 0 V, the
results would be identical to the analytically determined value up to the sixth significant

digit or so (mainly because the mesh does not produce perfect circles).

What this result tells us is that COMSOL is capable of reproducing analytical results. As

pointed out in section On Accuracy, this does not necessarily mean it reproduces
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measurement results up to the seventh digit. In other words, it does not mean the

significance is up to the seventh digit. Something similar goes for the currents.

RESULTS

Phase Charging Current

I In the Results toolbar, click (%5) Global Evaluation.

2 In the Settings window for Global Evaluation, type Phase Charging Current in the
Label text field.

3 Locate the Expressions section. In the table, enter the following settings:

Expression Unit Description

abs(ec.IO0_1)/1[m] A/km Phase 1 charging current
abs(ec.I0_2)/1[m] A/km Phase 2 charging current
abs(ec.I0_3)/1[m] A/km Phase 3 charging current

Icpha A/km Charging current per phase (analytic)

4 Click = Evaluate.

TABLE 2
I Go to the Table 2 window.

The results should be around 5.5 A/km. Furthermore, notice the current density
involved is quite small (on the order of 0.06 A/m?). In order to sce this, restore the
selection applied to the solution:

RESULTS

Selection
I In the Model Builder window, under Results > Datasets > Study 1/Solution 1 (soll) click
Selection.

2 In the Settings window for Selection, locate the Geometric Entity Selection section.

3 From the Selection list, choose Cable Domains.
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4 Click the " Zoom to Selection button in the Graphics toolbar.
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Displacement Current Density Norm (ec)
I In the Model Builder window, under Results click
Displacement Current Density Norm (ec).

2 In the Displacement Current Density Norm (ec) toolbar, click Plot.
3 Click the Zoom Extents button in the Graphics toolbar.

freq(1)=50 Hz Displacement current density norm (A/m?)
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This current density is about 2.95-107 smaller than the expected average out-of-plane

current density in the main conductors (as given by I0/Acon).

This tells us two things: For one, we may neglect this current density in the Inductive
Effects tutorial. Secondly, 3D models will usually end up focusing on the inductive part of

the device. The fact that this current density has any effect at all comes from the cable’s
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large longitudinal surface area. This topic is treated in more detail in the Bonding

Capacitive tutorial.

Another thing to notice is that the displacement current plot shows no currents in the
terminals. Halfway the tutorial, you have set the conductivity of the metals to 5 S/m, to
make the problem well-posed. Another approach is to exclude the metal from the model
altogether and consider its potential truly uniform. This is what the Terminal and
Floating Potential features do; they model perfect conductors (see section On Ill-Posed
Problems).

Lastly, you have seen that this model contains a detailed geometry and an elaborate list of
material properties. In the end, only one material property has been of any significance:
Exlpe- Additionally, only two geometrical propertics have been important: Ry and Ry (the
inner and outer radius of the XLPE respectively). Often-times, you will encounter
situations where it is unclear exactly what is important and what may be neglected. A Zizzle
numerical exploration can do wonders, even when you do not have the exact figures at
hand.

You have now completed this tutorial, subsequent tutorials will refer to the resulting file
as submarine_cable 02 capacitive_ effects.mph. The next tutorial in this series will

investigate bonding types from a capacitive viewpoint.

From the File menu, choose Save.
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